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Mission:

Goal

Indian Health Service 
Mission: 

The overall mission of the Indian Health Service (IHS) is to raise the physical, mental, social and 

spiritual health of American Indians and Alaska Natives (AI/AN) to the highest level. 

Goal: 

The main goal of IHS is to assure that comprehensive, culturally acceptable personal and public health 

services are available and accessible to AI/AN people. 

*It is impossible to achieve these without sufficient funding. 

3 



 

Learning Objectives 
• Resources, POS overview and setting up your POS system (RPMS) for billing of 

claims 

• Understand how to optimize Revenue Generation by becoming familiar with 

Daily/ Weekly/ Monthly Tasks to optimize POS 
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Resources - RPMS Recordings and Material Library 

• Click on this link and make the selections as shown in the picture below 
• RPMS Recording and Material Library | Training (ihs.gov) 

• Search for any term associated with these topics in the keywords box 

5 



  Resources - RPMS Recordings and Material 
Library 
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Point of Sale Billing Listserv: POS@listserv.ihs.gov

extremely

To gain access:

Topics Pharmacy Billing

Subscribe

POS Listserv 
Point of Sale Billing Listserv: POS@listserv.ihs.gov 

• This is an extremely useful tool. 
vQuestions can be asked to all POS users that are signed up throughout IHS. 

To gain access: 

1. Navigate to https://www.ihs.gov/listserv/ 

2. Click Topics and enter Pharmacy Billing in the search field. 

3. Enter your name and email and click Subscribe (see next few slides). 
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LISTSERV Email Groups 
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Pharmacy Billing Option 

9 



Sign Up 
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Point of Sale Office Hours 
• Occurs the Second Tuesday of every month from 11AM to 12PM CST 

v Can be longer depending on topic but usually no longer than 12:30PM 

• Different Point of Sale topic each month 
v Detailed information as to how to perform specific POS functions 

• Link is sent out to Pharmacy Billing Listserv and Business Office Listserv 5-7 days prior to Office 
hours 
v Sign up for Pharmacy Billing Listserv if not already subscribed 

• Different subject matter experts will be presenting on the various topics monthly 
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General Steps in the Point of Sale Process 
• Setting up your POS system (RPMS) for billing of  claims 

• Ensuring your are eligible to bill/contracted with third party payers 

• Acquisition of cards or proof of insurance 

• Entry of insurance information 
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General Steps in the Point of Sale Process (cont.) 

• Billing of claims 

• Correction of claim rejections 

• Completion of prior authorizations 

• Reconciliation of payments with business office 

• Counting all the money 
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POS Workflow 
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Each Department is a Piece of the Puzzle 
• Pharmacy plays a crucial role in generating revenue using POS but many departments are involved! 

• Registration, Benefits coordinators, business office, IT, Administration, and more! 
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Assigning Necessary Point of Sale Keys 
• Sailpoint (ITAC) request for each employee involved with POS 

v All Point of Sale users 

q ABSPZ Biller, ABSPZ Reports, ABSPZ User, ABSPZMenu (no space) 

• Restricted Keys (but necessary to maximize revenue) 

v At least one person in the pharmacy should have these keys (superuser) 

v ABSPZ Manager for Advanced setup of insurer 

v AGZMENU - Patient Registration Keys to enter insurance in a patient’s file 

v ABMDZ TABLE MAINTENANCE - Table Maintenance to add/edit insurer in insurer file 

menu and add/edit group 
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              *Pharmacy POS package not accessible with these keys

Business Office Keys do not include POS 
Functions 

• Billing clerk (Business Office) 
v ABMZMENU 

• Accounts Receivable clerk (Business Office) 
v BARZMENU 

*Pharmacy POS package not accessible with these keys 
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Information and Technology (IT): 
RPMS Patches and Informatics 

Keep current with RPMS patches (software updates) 

• Most site’s updates are performed when a new patch is released and forwarded to local IT from Area 
IT for installation 

• Will need to perform Drug Price updates periodically 
• Benchmark price updates 
• Acquisition price updates 

• Perform manually when drug NDC changes 

• Can update your entire drug file periodically 

• May require help from informaticist 

• https://www.youtube.com/watch?v=dxy891S8NP8 

• Follow up with your local IT and Informaticist to verify that these are being completed. 
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Activate Your Point of Sale Option 

• For Point of Sale to be “turned on:” 

v PIHS IHS-Specific Pharmacy Options 
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         Verify Patch is current in Pharmacy Point of Sale 
Menu (ABSP) 
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POS MGR SET PRI

Multiplier 1.5

POS Settings: MULTIPLIER 
• To view and/or edit your pricing formula and multiplier, enter: 

POS > MGR > SET > PRI 

• Multiplier: As a general rule, it should be set at 1.5. 

• Some sites use 1.9 to ensure collections are maximized on very expensive meds 
(i.e., Hepatitis C medications). 

• This takes the Benchmark price for the medication being billed and multiplies it 
by 1.5 and maximizes reimbursement. 
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Pharmacy:  Drug File Clean-up 
• Ensure that all medications are entered with the correct details 

• Correct brand, NDC (National Drug Code), and pack size that you are dispensing, 
order unit, qty dispensed message, etc 

• If utilizing Consolidated Mail Outpatient Pharmacy (CMOP) for mailing 
prescriptions, drugs must be matched to VA drug file 

• Develop a system to update the drug file every time the NDC changes 

• Automation makes this process easier (Scriptpro) 
• Will not scan an NDC its not expecting 
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^BILL – can set certain NDCs as unbillable

NAME Enter/edit unbillable drug names

Certain groups of medications can be made 
UNBILLABLE, if needed 

• ^BILL – can set certain NDCs as unbillable 

• NAME Enter/edit unbillable drug names 

• RPMS has system wide defaults entered. 
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         DEXAMETHASONE 4 MG/ML SOLN INJ(CLINIC)

System Wide Default Code (previous slide) 
• If the drug name contains any of the following then it will not go to POS: 

v (SAMPLE) 
v (ICP) 
v (OTC) 
v (INJ) 
v (ORX) 
v (CLINIC) 
v (VCP) 
v U/D <- NOTE: this is only entry that is not in parenthesis 

• Inpatient meds for outpatient (IMO) set up 
v Medications are processed through the inpatient package and do not get billed to outpatient POS 
v This is a quick order setting 

Example: DEXAMETHASONE 4 MG/ML SOLN INJ(CLINIC) 
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Pharmacy POS Tutorial 
Excel Document created as a one-stop shop for Pharmacy Point of Sale training. It 
includes: 

• Daily tasks/Reports 

• Correction of Common Rejections 

• Setup of Insurers/Special codes 

• Search for Insurance Eligibility for uninsured patients 

• Prior Authorization Resources, etc. 
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POS Tutorial 
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POS Daily Tasks 
•URM 
•DUP 
•STR 
•DAY 
•RCR & RRIP 
•Prior Authorizations 
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  POS--> RPT->MNT->URM

Update Report Master File Report (URM) 
• Why is running URM important? 

v Ensures that the most updated data is crossing over to Pharmacy POS reports, i.e. clears 
out rejections that have been fixed and gives an accurate total of RMPS reports 

v Report will clean-up any rejections that have been worked on by a different department 
(pharmacy, billing, etc.) 

• How do we run URM? 

v POS--> RPT->MNT->URM 
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URM continued….. 
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URM continued….. 
•IF URM has never been run – go back one year 

•IF URM has been run daily 
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Duplicate claims report (DUP) 
•How does Duplicate Claims in POS occur? 
vResults from an internet/connection issue 

vPOS Claim has been submitted in RPMS and: 

qIt does not show up as PAYABLE in POS and hence is resubmitted again 

qPOS Claim is resubmitted before we get a final response from the insurance company 

•Why do we want to fix DUP claims? 

vOne of the main reasons why insurance company denies an POS claims 

qNot staying on top of this means less revenue generation for your site 

qIf this is done daily, this report should not be long 
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              POS-> U -> RPT -> MNT -> DUP

DUP Continued….. 

•How do you run a DUP claims report? 

vRemember – this is done after running an URM report 

vPOS-> U -> RPT -> MNT -> DUP 
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DUP Continued….. 
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What do we do Next?..... 

•Resubmit the claim: 

vUsing Patient Name, Rx#, and med name: 

vBring up the patient in POS ( POS -> U -> EV -> 3) 
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What do we do Next?..... 
1. Pull up patient using patient’s name 

2. Look at claims that’s designated as “Duplicate” 

3. Resubmit the claim 
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What do we do Next?..... 
4. Enter the line # associated with DUPLICATE claims: 

5.  Successfully submitted: PAYABLE 
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                POS -> RPT -> MNT -> STR

Stranded Claims (STR) 
• Why do they occur? 

v Usually when connectivity to IHS network is interrupted 

q Good idea to check if there are power outages and/or changes to network 

• How to fix STR? 

v POS -> RPT -> MNT -> STR 
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STR cont….. 
•If it’s blank: that’s good…no stranded claims for your site: 
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Use of DAY Report to Monitor POS Collections 

1. Run report daily 
v Helps give an idea of daily impact of work being done by billing techs/pharmacists 
v POS -> U -> RPT -> ADMN -> DAY 

2. Run the report at the: 
1. Start of the day prior to working rejections 
2. End of the day after working rejections 
3. Subtract the End of the day from the Start of the day to see how much you gained by fixing rejected

claims. (Prove your worth) 

3. Can run the DAY report for one month or one year to track month to month progress/trends or
year to year progress/trends 
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DAY TOTALS - by RELEASED DATE 
POS-MGR-RPT-ADMN-DAY 

Shows totals for a selected date range, including: 
• PAYABLE – Totals of all PAID amounts for POS claims 

• SHORTED – Reflects difference in amount billed – (PAID+Copay) 
• PAPER – Total of all paper claims billed (Not Collected) 
• REJECTED – Total billed amount for all claims in rejected status 

• UNINSURED – Total billed amount of claims for Patients with no insurance listed on page 4 of their chart. 
• DUPLICATE – Total of all Duplicate claims (should be zero) 
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RCR Rejected Claims by Reject Code

Reports for Working POS Rejections 

•RCR Rejected Claims by Reject Code 

•Lists rejections by either Pharmacy, Insurer, or Reject Code 

v Report that will list all of the rejected claims for a given time frame that are needing 

fixed 

v Can print a summary or a detailed report 
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RCR Summary 
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RCR Rejected Claims by Reject Code 
Detail Listing 

REJECTION CODE: 60:Product/Service Not Covered For Patient Age 
LAST NAME,FIRST NAME 2727001/1P OKLAHOMA MEDICAID $ 11.66 
000179212 00904671746 CETIRIZINE HCL 10MG 

TAB 
LAST NAME,FIRST NAME 2732969/0P OKLAHOMA MEDICAID $ 10.83 
016445787 00904671772 CETIRIZINE HCL 10MG 

TAB 
LAST NAME,FIRST NAME 2734083/1P OKLAHOMA MEDICAID $ 11.66 
002459410 00904671746 CETIRIZINE HCL 10MG 
TAB 

REJECTION CODE: 75:Prior Authorization Required 
LAST NAME,FIRST NAME 2735153/0P OKLAHOMA MEDICAID $302.50 
004361371 
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RRIP - RPMS Report and Information Processor 

• Converts RCR report into Excel form 

• Keeps track of statistics related to working of rejections 

• Created by Nick Sparrow and is Available on the Pharmacy POS Listserv: 
pos@listserv.ihs.gov 
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Pharmacy Report Processing Menu 
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RRIP Changes RCR Report From This… 

REJECTION CODE: 60:Product/Service Not Covered For Patient Age 
LAST NAME,FIRST NAME 2727001/1P OKLAHOMA MEDICAID $ 11.66 

000179212 00904671746 CETIRIZINE HCL 10MG 
TAB 
LAST NAME,FIRST NAME 2732969/0P OKLAHOMA MEDICAID $ 10.83 

016445787 00904671772 CETIRIZINE HCL 10MG 
TAB 
LAST NAME,FIRST NAME 2734083/1P OKLAHOMA MEDICAID $ 11.66 

002459410 00904671746 CETIRIZINE HCL 10MG 
TAB 

REJECTION CODE: 75:Prior Authorization Required 
LAST NAME,FIRST NAME 2735153/0P OKLAHOMA MEDICAID $302.50 
004361371 
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…To This Easy to Read Excel Form! 
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File -> Log Session – Create Report – Create a file name

Click on Log Session again to turn this off

Detailed instructions for RCR & RRIP 

• RRIP Database - > Rejected Claims by Rejection Claims Report 

v If it’s the first time you are opening this, format the data column based on the information that you want to capture 

• Secure CRT 

v POS -> U -> RPT - > CLA –RCR 

q Enter date range (this depends on site specific workflow): 

o Example: t-11 to t-1 

q Select Pharmacy: based on each site 

q Insurer – ‘blank’ 

q REJECTION CODE – ‘blank’ 

q S or D 

q DEVICE: HOME// 0;180;999999 – DO NOT HIT ENTER  yet 

o File -> Log Session – Create Report – Create a file name 

o Click on Log Session again to turn this off 
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Detailed instructions for RCR & RRIP… 

•Go back to RRIP Report Processor 
vList of Rejected Claims – use this to start working on the specific rejections 

•Rejection report can be divided and tracked based on staffing 
availability 
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POS/MGR/RPT/CLA/ERCR

ERCR Enhanced Rejected Claims by Reject Code 

RCR report has been enhanced: POS/MGR/RPT/CLA/ERCR 

• Includes a delimited output 
vSummary, Detailed, and Text Delimited outputs available 

• Sorting Function 
vSort by Fill Date, Transmit Date, and Release date 

• Added Data Elements 
vFill Date, Transaction Date, RX IEN, Claim#, INS DOB, HRN, and Additional Payor Messages 
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ERCR Text Delimited Output Option 
• To navigate to the ERCR, go to POS>MGR>RPT>CLA>ERCR 
• Select either Fill, Transmit, or Release date and enter date range 

• At Device: Home// prompt, enter HFS and hit enter 

• Enter a name for your report so you can identify it 

• Report will print to Host Drive at your site 
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Opening ERCR in Excel 

• Open Excel, click File, and then click Open from the dropdown 

• Go to the Host drive and select your file you created 
vClick All Files and sort by most recent date to find it easier 
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Opening Delimited Text File in Excel 
• Select Delimited, and then Click Next 

vNotice the highlighted portions.  This shows us that the ^ is our delimiter 
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Enter your Delimiter 
• Click the Box next to Other 

• Enter ^ as the delimiter 
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   Fine Tune ERCR in Excel 
Expand your columns to view the data 

Highlight Row 1, then Click Data, then Click Filter. 
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ERCR Report Compared to RCR/RRIP 

Pros 

• ERCR provides more detailed claim information than the RCR/RRIP 
• HRN, Claim IEN, Insurer DOB, Additional Payor Messages 

• Do not have to set up the RRIP on your computer 

Cons 

• Once setup, RRIP has fewer steps to process a more concise report 
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Prior Authorizations 

Division Fill Date Chart# Rejection Drug Name NDC Status Insurer Amount Billed 

CHINLE 05/07/24 75:Prior Authorization Required PEN NEEDLE 31G 8MM 08496310601 CVS CAREMARK $12.29 
CHINLE 05/07/24 75:Prior Authorization Required ALOGLIPTIN 25MG TAB 45802015065 CVS CAREMARK $394.50 

CHINLE 05/07/24 75:Prior Authorization Required INSULIN GLARGINE SOLOSTAR 100 UNIT/ML PEN 00088221905 CVS CAREMARK $235.81 
CHINLE 05/07/24 75:Prior Authorization Required ACCU-CHEK GUIDE ME GLUCOSE TEST STRIPS 65702071910 OPTUM RX-IRX $44.50 
CHINLE 05/07/24 75:Prior Authorization Required GLUCOSE SENSOR FREESTYLE LIBRE 2 57599080000 RX-OPTUM MCD 001553/AI $268.78 

CHINLE 05/07/24 75:Prior Authorization Required CERTOLIZUMAB 400MG/2ML KIT 50474071079 RX-OPTUM MCD 001553/AI $10,876.57 
CHINLE 05/07/24 75:Prior Authorization Required LEVOTHYROXINE 75MCG TAB 00074518219 RX-OPTUM MCD 001553/AI $100.03 

CHINLE 05/07/24 75:Prior Authorization Required INSULIN GLARGINE MAX SOLOSTAR 300 UNIT/ML 00024587102 RX-OPTUM MCD 001553/AI $120.45 
CHINLE 05/07/24 75:Prior Authorization Required EPLERENONE 25MG TAB 59762171002 RX-OPTUM MCD 001553/AI $249.40 

CHINLE 05/07/24 75:Prior Authorization Required INSULIN ASPART 100 UNIT/ML NOVOLOG FLEXPEN 00169633910 RX-OPTUM MCD 001553/AI $328.65 
CHINLE 05/07/24 75:Prior Authorization Required LIRAGLUTIDE (VICTOZA) 6MG/ML INJ 00169406013 RX-OPTUM MCD 001553/AI $1,356.49 
CHINLE 05/07/24 75:Prior Authorization Required MYCOPHENOLATE SODIUM 180MG DR TAB 60505296507 RX-OPTUM MCD 001553/AI $260.11 

CHINLE 05/07/24 75:Prior Authorization Required SEMAGLUTIDE 7MG TAB 00169430730 RX-OPTUM MCD 001553/AI $1,850.30 
CHINLE 05/07/24 75:Prior Authorization Required INSULIN ASPART 100 UNIT/ML NOVOLOG FLEXPEN 00169633910 RX-OPTUM MCD 001553/AI $169.38 

CHINLE 05/07/24 75:Prior Authorization Required SEMAGLUTIDE (OZEMPIC) 2 MG DOSE INJ PEN 00169477212 RX-OPTUM MCD 001553/AI $1,850.30 
CHINLE 05/07/24 75:Prior Authorization Required LEVOTHYROXINE 100MCG TAB 00074662419 RX-OPTUM MCD 001553/AI $99.99 

CHINLE 05/07/24 75:Prior Authorization Required SEMAGLUTIDE (OZEMPIC) 0.25MG/0.375ML INJ P 00169418113 RX-OPTUM MCD 001553/AI $1,850.30 
CHINLE 05/07/24 75:Prior Authorization Required SEMAGLUTIDE (OZEMPIC) 0.25MG/0.375ML INJ P 00169418113 RX-OPTUM MCD 001553/AI $1,850.30 
CHINLE 05/07/24 75:Prior Authorization Required AMLODIPINE 5/BENAZEPRIL 20MG CAP 68180045901 RX-OPTUM MCD 001553/AI $22.94 

CHINLE 05/07/24 75:Prior Authorization Required DUPILUMAB 200MG/1.14ML PEN INJ 00024591902 RX-OPTUM MCD 001553/AI $7,236.19 
CHINLE 05/07/24 75:Prior Authorization Required LEVOTHYROXINE 50MCG TAB 00074455219 RX-OPTUM MCD 001553/AI $95.71 

CHINLE 05/07/24 75:Prior Authorization Required ECONAZOLE NITRATE 1% CREAM 51672130302 RX-OPTUM MCD 001553/AI $105.22 
CHINLE 05/07/24 75:Prior Authorization Required FLUTICASONE/SALMETEROL 500/50MCG DISKUS 00378932232 RX-OPTUM MCD 001553/AI $301.08 

CHINLE 05/07/24 75:Prior Authorization Required SEMAGLUTIDE (OZEMPIC) 1 MG DOSE INJ PEN 00169413013 RX-OPTUM MCD 001553/AI $1,850.30 
CHINLE 05/07/24 75:Prior Authorization Required MEMANTINE 10MG TAB 29300017205 RX-OPTUM MCD 001553/AI $34.05 
CHINLE 05/07/24 75:Prior Authorization Required ISOTRETINOIN 40MG CAP 69238117603 RX-OPTUM MCD 001553/AI $404.13 

CHINLE 05/07/24 75:Prior Authorization Required TRETINOIN 0.025% CREAM 00378808220 RX-OPTUM MCD 001553/AI $169.16 
CHINLE 05/07/24 75:Prior Authorization Required LEVOTHYROXINE 25MCG TAB 00074434119 RX-OPTUM MCD 001553/AI $55.07 

CHINLE 05/07/24 75:Prior Authorization Required TRETINOIN 0.025% CREAM 00378808220 OPTUM RX-KIDS CARE $171.92 
CHINLE 05/07/24 75:Prior Authorization Required TRETINOIN 0.025% CREAM 00378808220 OPTUM RX-KIDS CARE $171.92 

CHINLE 05/07/24 75:Prior Authorization Required ALBUTEROL SULFATE 0.083% NEB INHL 3ML 76204020030 D-CIGNA SECURE RX $21.90 
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POS Weekly Tasks 

•Paper Claims Report 

•Missed Prescriptions Report 

•Negative COPAYs Report 
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Paper Claims Report 

•POS -> RPT -> ClA -> PAP 
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PAP cont….. 

•Only VA Medical Benefit Plan should show up on these paper claims 

•IF you have access to Third Party Plan: 
vCan check to see if the respective paper claims have: 

qU - Unbillable 

o Technically, no insurance plans should be marked as such but at Chinle, Dental 
claims are marked as U 

qO – Outpatient Drugs Only (Medical Insurance but no Rx Insurance) 

qP – Point of Sale 
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Missed Prescriptions Report 

•POS / RPT / MNT / MISS

•Rx has been processed but did not cross over

vLook at the claims that does not have any message associated with the claim.
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MISSED COPAYS REPORT 
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Fileman is Not

FileMan Negative Copay report 

• Fileman is a useful tool to make custom reports for almost any needed parameters 

• Fileman is Not user friendly 

• Examples of FileMan reports: 

• FileMan report to identify POS claims with negative reimbursement (example is on the 
next slide) 
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FileMan Report to Identify Claims with Negative Copays 

Select VA FileMan Option: PRINT File Entries 

OUTPUT FROM WHAT FILE: ABSP REPORT MASTER// 

SORT BY: RELEASED DATE// 

START WITH RELEASED DATE: FIRST// T-30 (JUL 27, 2016) 

GO TO RELEASED DATE: LAST// T (AUG 26, 2016) 

WITHIN RELEASED DATE, SORT BY: 

FIRST PRINT FIELD: RELEASED DATE 

THEN PRINT FIELD: ";" 

THEN PRINT FIELD: TRANSACTION:PHARMACY 

THEN PRINT FIELD: ";" 

THEN PRINT FIELD: RXI:DRUG 

THEN PRINT FIELD: ";" 

THEN PRINT FIELD: TRANSACTION:PATIENT 

THEN PRINT FIELD: ";" 

THEN PRINT FIELD: TRANSACTION:NET 

By 'NET', do you mean ABSP LOG OF TRANSACTIONS 'NET PAID BY INSURER'? Yes// 

(Yes) 

THEN PRINT FIELD: ";" 

THEN PRINT FIELD: TRANSACTION:INSURER 

THEN PRINT FIELD: 

Heading (S/C): ABSP REPORT MASTER LIST Replace @ 

STORE PRINT LOGIC IN TEMPLATE: 

DEVICE: 0;999;9999 <<Open session log before pressing Enter>> 

64 



 
 

    
 

       

   

      

                    

Data, From text/CSV

Transform Data

close and load

AS LONG AS IT IS GETTING DONE ON A SCHEDULED BASIS

Import Fileman Negative Copay report into Excel 
1. Once you have run the file to completion, and have successfully created a text document with your 

data using “log session,” open Excel 
• Use log session as you would for the RCR when getting it ready to use in the RRIP i.e. at the “print” prompt type 

“; 

2. At the top, click Data, choose From text/CSV 

3. Select your file 

4. Excel will automatically identify how the data should be organized and will display a sample 

5. Click Transform Data 

6. Then click close and load 

7. Organize your copay column smallest to largest and all of the negative copays are displayed at the top 

8. Save the spreadsheet and reverse the claims with negative copays! 

The general recommendation is to do this daily to keep your reports as accurate as possible, but this could 
be done weekly to monthly AS LONG AS IT IS GETTING DONE ON A SCHEDULED BASIS 
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Example of Negative Copay Report converted to Spreadsheet 
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Example of Negative Copay Report converted to Spreadsheet 
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POS Monthly Tasks 

•VGEN 

•DAY report 

•RCR summary 
•STA summary 
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Will have the biggest impact on revenue collection via POS

VGEN 

• Will have the biggest impact on revenue collection via POS 
vHelp find insurance coverage for uninsured patients 
vCreate a list of uninsured patients 

• ^̂VVGGEENN -->> PPrreeddeeffiinneedd OOrrddeerr -->> SSeelleecctt AAllll VViissiittss -->> DDaattee RRaannggee -->> PPrreevviioouussllyy DDeeffiinneedd RReeppoorrtt 
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VGEN Cont…. 

• Visit Selection Menu -> S -> Any Third Party Coverage & Any Medication Prescribed (#35, #172) 

• Enter Quit Item Selection 

•Next Screen – Select Detailed Visit Listing 
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VGEN Cont…. 

• Print Selection Menu -> Patient Name, Chart#, DOB, Mlg Address-Zip 

•Each parameter and # of characters allowed will be listed – hit enter and accept defaults 

•Enter Quit Item Selection to Sort Item Selection Menu 
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VGEN Cont…. 

•Sort Selection Menu and choose how your report will be selected – PATIENT NAME 

•Next, follow the prompt and select the default except for highlighted area 
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VGEN Cont…. 
•Compile Report:
vIF you have access to PUB drive:

vNo Access to PUB drive: Secure CRT to log session: 
v Log once you reach the prompt to Print

qHit Enter
qDevice: HOME//0;180;999999999
qHit Enter X 2
qDeactivate Log Session
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VGEN Cont…. 
•Pull up Word Document of the save report 
vDelete unnecessary information and save 

qClose out the word document 
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VGEN Cont…. 
•Compile report cont… 
vOpen New Excel Document 

q Select Data and then Form Text/CVS -> All Files - > pull up the Saved Report - > Import 
qBox pops up with different column headings 
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VGEN Cont…. 
•Compile report cont… 

q Select “Fixed Width” in the Delimiter Column and type, in 0,22,25,35,49 

o Select Transform Data -> Load 
o Rename Column: Patient Name, Chart#, DOB, Zip Code 

o Select Design -> Remove Duplicates Save Report 
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VGEN Cont…. 
• Once report is created: use tools to find coverage for PI and Medicare Part D 
v Change Healthcare Cardfinder 
vRPMS Medicare Part D Eligibility 
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DAY Report 
•Run at 1st of month for previous month’s data 
• Helps get a monthly assessment of revenue collection. 
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Knowledge Check #1 
The _________ takes the benchmark price from the drug file and _________ it 
times whatever value that is entered. It should be set at ____ as a general rule. 

A. Subtractor; subtracts; 1.5 
B. Divider; divides; 2.5 
C. Multiplier; multiplies; 1.5 
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Knowledge Check #2 
True or False: 

The POS Listserv is, in my opinion, the most helpful tool when it comes to answering 
your POS questions. 
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Knowledge Check #3 

A. True or False 

The DAY report is one of the most user friendly and informational reports to track 
your POS progress 

B. True or False 

Printing the RCR and going through rejections on paper is the most efficient way to 
correct rejections 
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stay get

Do not exceed a 90-day window for correction/back billing

Some Medicaid plans will allow 180 days

RECAP 
Develop a daily routine that works at your site and follow it. 

• Use the POS tutorial!
• It is a great resource

• Reach out to POS listserv if you cant find the answer to your question on the POS tutorial

• Run daily reports, work rejections, complete PAs.
• Start with refill too soon, then correct any Medicaid rejections (if getting all inclusive rate), and then high cost meds if your time is limited

• Keep track of your data.  Increased collections will prove your worth

• Use DAY report to do this – It’s simple!

• Do not get too far behind! It is much easier to stay caught up than to get caught up. 
• Work on the previous days rejections

• Do not exceed a 90-day window for correction/back billing 

• Some Medicaid plans will allow 180 days 

• Do not forget the Monthly Reports which help to Identify underlying problems.
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Questions & Discussion 

Nivedita Das 

Chinle Comprehensive Health Care Facility 

Nivedita.Das@IHS.Gov 

928-674-7041 
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